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1 - Getting Started
Welcome to MapInfo Stratus Help. To get started, refer to the following
help topics:

In this section

Overview 4
Browser Requirement 4
Version Number and Build Number 5
Signing In and Out 5



Overview

TheMapInfo Stratus is an interactive mapping service provided by Pitney Bowes Software. It provides
access to mapping and geographic-based information, addresses and postcode searches.

It also allows you to:

• Browse current maps and data

• Switch between different background maps such as aerial maps and road maps

• Zoom in and zoom out of maps

• Search and find addresses and postcodes

• Add more information to your map (overlays)

• Get information about what's on the map by clicking the map

• Search for what services and facilities are nearby to an address

• Search for data within the current map or in a shape you draw

• Search for data using various criteria

• Measure areas and distances

• Draw annotations on the map

• Print maps to a PDF file

• Create a link to launch the map later at the same location

• Retain X, Y, View and Zoom on switching Map Configuration, if the projections are same.

The system presents map detail appropriate to the level of zoom.

Browser Requirement

The MapInfo Stratus supports following browsers:

• Microsoft Internet Explorer 9.0 10 and 11.

• Mozilla Firefox 38.0

• Safari 7.0.5 on Mac
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• Google Chrome 43.

• iPad (Admin Console is not supported in iPad)

Internet Explorer 6, 7 and 8 are not supported. However, older versions of Firefox, Safari
and Chrome are supported.

Note:

Version Number and Build Number

The MapInfo Stratus displays version number along with build number at the bottom of the page.
However, it is not available all the time. You need to append "?getVersion=true" at the end of
the MapInfo Stratus URL.

Signing In and Out

MapInfo Stratus allows you to work as a Guest User for some authorized configurations. However,
if you sign in with your credentials you may get access to all the resources (configurations) for which
you have been authorized. MapInfo Stratus has a role based access and a user can sign in with
different role.

In case you don't have login information then please contact your Administrator to get login
credentials.

Note:

Signing In to MapInfo Stratus

To Sign-in to your account:

1. In the Map toolbar, click on Sign-in icon. The Sign-in page appears.
2. Fill in your account information.

User name and password are case sensitive.Note:

3. Click Submit button. The MapInfo Stratus application appears with your credentials.

Signing Out from MapInfo Stratus

To Sign-out from your account:

1. In the Map toolbar, click on Sign-out icon.
2. You have successfully signed out. Click on MapInfo Stratus Home Page to return to the map

view.
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2 - Learn the Basics
The following topics provide help on individuaMapInfo Stratus features:

In this section

Views 7
Maps 7
Toolbar Features 8
Tooltips 9
Navigating in the Map 10
Map Information Callout 12
Changing Map Center 12
Switching Base Maps 13
Map Legend 14
Status Bar 14
Getting Help 15



Views

MapInfo Stratus allows you to select various views located at the top left corner of the viewport. You
can select:

DescriptionViewIcon

It showsmap and results vertically. This
is the default view.

Vertical View

It shows map and results horizontally.Horizontal View

It is map only view. The search and
query panel is hidden.

You can click on the Search\Query view
icon on the left side of the map to
display Search and Query panel.

Map View

It is results only view. The map is
hidden.

Result View

You can drag the splitter between the results/query panel and map to resize its position.Note:

Maps

MapInfo Stratus provides list of available maps at the center of the toolbar. You can select maps
from the Maps drop-down list.
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Toolbar Features

MapInfo Stratus toolbar is located at the top right corner of the viewport. Based on annotation
preferences selected in the Administration Console, you can use one of the following toolbar at a
time:

Annotation Toolbar

It displays all annotation tools. The table below lists the feature available in Annotation Toolbar:

DescriptionNameIcons

Navigate Map (pan to move and click
to see info)

Navigate Map

Select an annotation to see its
properties

Select Annotation Tool

Pick a map feature to add it to your
annotations

Pick from map

Draw a line annotationDraw Line

Enter a text annotationText Annotation

Draw a point annotationDraw Point

Draw a shape annotation (one of the
following)

Draw a shape annotation

Draw a PolygonDraw Polygon

Draw a CircleDraw a Circle

Draw an EllipseDraw an Ellipse
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DescriptionNameIcons

Draw SquareDraw Square

Draw RectangleDraw Rectangle

Draw Concentric RingDraw Concentric Ring

Manage AnnotationsManage Annotations

Measuring Toolbar

It displays measuring tools. The table below lists the features available in Measuring Toolbar:

DescriptionNameIcons

Navigate Map (pan to move and click
to see info)

Navigate Map

Measure a lineMeasure Line

Measure an areaMeasure Area

Clear annotation featuresClear Feature

Tooltips

MapInfo Stratus tool tips provide additional information about each field.

For example, to see a tool tip for an attribute in the left panel, hover-over the attribute.
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Navigating in the Map

MapInfo Stratus navigation tools help you to explore the map visually.

Zooming In and Out

There are numerous ways to zoom in and out of the maps.

1. Click the + or - buttons on the zoom bar.
2. Move the zoom slider up or down the zoom bar.

3. Hold the SHIFT key down your keyboard, then click and drag the cursor to form a rectangle on
the map. The map will then zoom into the specified area.

4. Right click on the map and select Zoom Out or Zoom In from the right click menu.
5. Simply position the cursor on the map and zoom in or out by scrolling the mouse wheel forward

or backwards.
6. When the Navigate Map tool is selected double click the map to zoom in one level.

For more information, refer to Frequently Asked Questions.Note:

Copy X-Y and Longitude and Latitude Values

You can copy X and Y value of the current position to the clipboard in the map.

1. Right click on the map and click on the Display X-Y from the right click menu to copy x-y value
to the clipboard.
The Info dialog box appears with x-y and longitude and latitude values of the current position.

2. Select the values to copy either by right-click menu or ctrl+c keyboard option.
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3. Click Ok to close the Info dialog box.

The x-y and Longitude and Latitude values are displayed in all the callouts.Note:

Moving around the Map

To move around the map, perform the following steps:

1. Click on any of the four points on the panning star. It allows you to pan north, pan south, pan
west and pan east.

2. When the Navigate Map tool is selected, click on the map screen, hold the mouse, click down
and drag the cursor across the screen to move around the map.

3. Click on the Initial Map View button in the center of the pan (highlighted) to take the map to the
initial view.

Using the Keyboard Keys

You can use keyboard keys to navigate around the map. Use Access Key (Alt + 1) to focus the map
element, and then use following keys to pan and zoom:

ActionKeyboard Keys

Zoom In+

Zoom Out-

Pan NorthUp Arrow
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ActionKeyboard Keys

Pan SouthDown Arrow

Pan EastLeft Arrow

Pan WestRight Arrow

Map Information Callout

A callout shows information about features displayed on a map.

To see more information about a feature, click on the map. A callout appears showing the attribute
information for all of the features at that location. The information will vary from feature to feature
but can include:

• The X and Y with Longitude and Latitude
• The title and description of the feature
• A link to a web site for more information about this feature
• An image or logo representing the map feature
• Any other attribute data relating to the feature
• A hyperlink link to see additional related data which is displayed in the 'Search Results' tab
• A link-out to show feature data in an external application.

The callout feature is available on the basis of settings done in Admin Console. You may
not see all the above mentioned information in the callout.

Note:

Changing Map Center

It allows you to locate the map to X and Y value that you have provided. You can enter values in
longitude and latitude in addition to the current projection of the map. It also allows you to view your
current position on the map.

To change the Map center x-y value:

1. Click on the Map Center link to open the Map Center dialog box. It displays following options:
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DescriptionOption

It displays the current map project. For example,

EPSG:3857
Current Map Projection

Select XY radio button to modify the value of x and y.

The X and Y text boxes displays current values of X and Y initially.

XY

Select Longitude/Latitude radio button if your input values are
longitude and latitudes in decimal degree.Longitude-Latitude

Click on the Locate Me icon to see your current position on map.

This features is not supported by IE8.Note:

2. Click on the Apply button to change the map center.
3. Click on the Cancel button to discard the changes and close the Map center dialog box.

This option is available on the basis of settings done in Admin Console.Note:

Switching Base Maps

You can switch to a different type of background map. For example, Aerial, Hybrid or Roads map.
The switch background map option is located at the top right corner of the map.

From the drop-down list, select Aerial or Hybrid or Roads options to switch from one base map to
another.

Based on the settings done in Admin Console, you can retain X, Y, View and Zoom while
switching the Map Configurations with same projections.

Note:
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Map Legend

Map legends is located at the top right hand side of the map. It shows a key to the map overlays
and thematic map available on your map. It also allows you to turn on or off individual overlay’s and
individual layers in a map to show only the maps more appropriate to your requirements. It also
allows you to adjust translucency of a layer.

You can perform following actions by using Map Legend:

1. Click on the Show\Hide Overlay on the Map check box next to the required map overlay in the
legend to turn on a map overlay. Overlay check boxes can show following three states:
a) Checked- when all children layers are checked.
b) Unchecked- when all children layers are unchecked.
c) Indeterminate(solid color filled)- when some and not all layers are checked.

2. Click on the Show\Hide Layer on theMap check box next to the required layer under the overlay
to turn on a layer.

3. Click the overlay name or the arrow next to the overlay name to expand or collapse the legend
display for an overlay.

4. Click on theOpacity control icon and adjust translucency by using Layer Opacity slider to adjust
translucency of a layer.

5. Click on the Label icon to show or hide the label layers on the map.

The Opacity Control icon appears only when Show\Hide Overlay on the Map check box
is clicked. The individual Layer Show\Hide option is available based on settings done in
Admin Console.

Note:

Click on theDelete icon next to the thematic map legend to delete it. The delete option
is only available for thematic map and Query results.

Note:

Status Bar

Status bar at the bottom of the viewport displays the scale and the current X and Y as you hover
the mouse over the map.
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Getting Help

MapInfo Stratus provides online help for all the features.

To access online help:

1. In the Map toolbar, click on help icon to view online help.
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3 - Search and Query
Builder
The following topics provide help on search and query builder:

In this section

Search for an Address 17
Find my Nearest 19
Search Results 19
Query Builder 20



Search for an Address

MapInfo Stratus provides search bar on the top left corner of the viewport. It searches for place or
location that you'd like to view. Search results are displayed on the Search Results panel.

Searching ZIP Code, Placename or Address

MapInfo Stratus provides search for an address, place name and ZIP code. Your search may include
a single phrase or number or any combination of multiple phrases or numbers separated by a space.
This can include:

• The road name
• Property number and name
• Property number and ZIP code
• Full Postcode
• Part of a postcode
• Mix of postcode and road name (full or part)
• Place name (for example, school)

To search for an address, place name or ZIP code, follow the steps given below:

1. Enter part of an address (for example, ZIP code, street name etc.) in the search bar on the top
left corner of the viewport.

2. Click Search.
List of matching addresses are displayed in the Search Results panel.

3. In the Search Results panel, click on the address of your interest.
4. The address is marked on the map with a map-marker.

Using Wildcards when Searching

MapInfo Stratus supports following two wildcard characters:

1. A “*” can be used in place of multiple characters.
2. A “?” can be used in place of any single character.

The most common form of wildcard search is where you place a * at the end of the phrase you are
searching.
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For example, searching for “cam” may return results such as “Cam Road” but it will not return
“Camden Road”. Searching for “cam*” will return results that start with “cam”. For example “Camden
Road” and “Cambridge Road” would be returned if they were present in the dataset being searched.

A single character wildcard can be used where you are unsure of the spelling. For example searching
for “jo?ner” would return both “joiner” and “joyner”.

A wildcard is only supported if it is in the middle or end of a phrase. For example you cannot search
“*way”. Searching in this way will return no results.

More Search Options

MapInfo Stratus supports following search options:

Special characters: Any characters other than * and ? will be searched literally. This includes
characters such as “\” “/” and brackets. If for example the address data has text enclosed in brackets,
for example if all underground stations are indicated with brackets like this “Kentish Town Road
Station (Underground)” and you wish to search all underground stations then you must include the
brackets and search for “(underground)”.

Number Ranges: For number searches, you can search for either a single number or a number
range using two numbers. If searching for two numbers you can separate them using a dash or
space. Given below are the four sample searches:

1. “8-12 High Street”
2. “8 12 High Street”
3. “8 High Street”
4. “12 High Street”

In cases 1 and 2 the results will include addresses where both 8 and 12 are present in the address.
Results that contain only an 8 or a 12 are not returned. In case 3 if you searched for a single number
such as “8 High Street” you would see results returned that include 8 as a single number or as a
number range. Hence 1, 2 and 3 returned.

Similarly, in case 4 a search for “12 High Street” would return results 1, 2 and 4. However, a search
for "10 High Street" would not return results for "8-12 High Street". We make no assumption that
the range 8-12 includes number 10. Only results that are for 10 High Street or which include 10 in
a number range such as 10-12 High Street would be returned.

Apostrophes: If you have an address that has “’s” in the string like king’s, then you can use either
kings or king’s to search and any results that have “kings” or “king’s” will be returned. You do not
need include the apostrophe, but if you do, then the results will still be the same.

Quotes: If you are using quotes “” in your search, you might get unexpected results as MapInfo
Stratus will explicitly search for terms that include the quotes in the address. We recommend not
to use quotes.
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UKPostcodes: For UK Postcodes you can search the inner or outer code or specify the full postcode.
If specifying the full postcode you can enter it either using a space between the inner and outer
code or enter the whole postcode without spaces. MapInfo Stratus will correctly search and find the
matching postcodes.

Recently Selected Addresses

In the Search Text box, before typing any text, if you click the down arrow it displays recently selected
addresses.

As you type within the search box, it displays searches that might be similar to the one you are
typing. It displays top five results for what you have typed in so far.

Find my Nearest

Whenever an address search is carried out, the address is marked on the map with a map marker
offering links to show nearby services. Each link displays up to ten closest features/events of the
selected type.

By clicking on one of the link, nearest locations in that category are added to the map.

Finding more Information about Nearby Services

There are two ways of getting more information about nearby services.

1. Place the cursor over a map marker without clicking it. This will cause the map marker to grow
in size, and the corresponding details listed in the Search Results panel will be highlighted.

2. Click once on a map marker. A call out with more information about the selected feature appears.
It also displays x-y and longitude and latitude values of the selected feature.

Search Results

Search results are displayed in the Search Results panel located on the left pane.
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Query Builder

The query builder allows you to search for information on individual map layers shown on the map.
Results are displayed as an interactive table. Clicking a result on the table will zoom to and highlight
that feature on the map. You can search and display all of the data for a layer, constrain your search
to within the current map view, or search for information which is inside the shapes that you draw
on the map as annotations. For some layers the MapInfo Stratus Administrators will have set up
additional criteria that you can choose to further limit the results you get (for example, to return
results within a date range or results which meet some other value).

A query can be set up to perform a more detailed search on a map. Query now also supports Date,
Time and Date_Time data types. You can set your query based on following parameters:

DescriptionQuery Options

Allows you to specify the geographic area to search in. You can choose to see all the data, data
within the current map view or choose one of the annotations you have drawn to search for data

Query In

that is inside or touches it. If there are more than one annotation present on the map then two
more options will be available to choose from- Selected Annotations and All Annotations.

The name of the map layer you wish to search.From

You can choose which column of data to sort the results by. You can also re-sort the data once
the results are shown.

Sort by

Some layers will have a list of criteria you can choose. If criteria exist you will be presented with
additional text boxes or pick lists to further refine the results you return.

Filter

• No Filter- No criteria is selected.
• Custom Filter- Displays Filter Criteria dialog box and allows you to customize your search.
For more information, refer to Building a Query.

• Others- In addition to above two filter options, the query filter created from Admin Console are
also listed.

Now, you can select multiple options from query pick list and query on multiple options
at once.

Note:
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Building a Query

TheQuery Builder tab allows tabular queries on the attribute data from any of the currently displayed
layers.

To build a query, follow the steps given below:

1. Select the Query Builder tab.
2. From the Query In drop-down list, select the geographic area to be queried. You can choose

to see all the data, data within the current map view or choose one of the annotations you have
drawn to search for data that is inside or touches it.

3. From the From drop-down list, select the name of the map layer you wish to search.
4. From the Sort By drop-down list select which column of data to sort the results by. You can also

re-sort the data once the results are shown.
5. Select Custom Filter from Filter drop-down list to customize search. The Filter Criteria section

is displayed.
6. From theWhere drop-down list select the column that is to be queried.

If there are less than 50 records associated with selected column then criteria is shown
as drop down list with multiselect option and if records are more than 50 then criteria is
shown as text box.

Note:

7. Select the search operator from the drop-down list. It provides following search operators.

DescriptionNameOperator

This function only retrieves records that exactly match the text or value
entered in the criteria text box.

equal to=

This function looks for all values that are different from the value entered
in the criteria text box.

not equal to<>

This function looks for all values lower than the value entered in the
criteria text box.

less than<

This function look for all values higher than the value entered in the
criteria text box.

greater than>

This function looks for all values higher than or at the same level as
the value entered in the criteria text box.

greater than or equal
to

>=

This function looks for all values lower than or at the same level as the
value entered in the criteria text box.

less than or equal to<=
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DescriptionNameOperator

It looks for records in the chosen field that contain the criteria entered
in any way.

LikeLike

Multiselect pick list is supported for {equal, not-equal and like} operators. For others,
simple pick list is displayed.

Note:

8. Enter a value in the Criteria text box and click Go.

9. Click sign to add AND conditions to the query filter. If you want to delete a query condition

click the button to delete the current row.

You can add up-to 5 search criteria.Note:

Query Results View

On the query results tab you can:

• Re-order the results by clicking the column headings.
• Navigate from page to page.
• Export all of the results as a CSV file (or choose to export one page at a time). A maximum of
1000 results can be exported at any one time.

• Click each result to zoom to and highlight the record on the map.
• The highlighted feature can be used to make a second query inside its area.
• Resize the column widths by dragging the edges between the columns.
• Switch between horizontal, vertical or full results views to see more of the data.
• You can open as many queries as you like and each will be shown in its own tab.
• You can also close query result tab.
• You can link-out query results to external application. For more information, refer to Open In...
• You can add query results on the map. For more information, refer to Add to Map on page 22.
• You can also print query results. For more information, refer to Printing Maps on page 50.

Add to Map

You can add queries to the map directly from the Query Results.

To add query to the map, follow the steps given below:

1. Click on the Add to Map button to see query results on the map. The query result is also added
to the Map Legend under the heading Query Results.

Only one query result is added to the Map Legend at a time.Note:
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2. Click on individual geometry that came up as a Query Result. You can view its attribute in a
callout.

3. Click on the Info icon in the Map Legend to view query information. It displays the query
used for fetching the query results map layer.

4. Click on the Delete icon to delete query results from Map Legend.

You can also print query results. For more information, refer to Printing Maps on page 50.
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4 - Thematic Mapping
MapInfo Stratus allows you to apply themes on maps. Thematic mapping
allows you to analyze your data and display it in a variety of ways on a
map.

The Thematic Map feature is available on the basis of settings done
in Admin Console.

Note:

In this section

Introduction 25
Creating a Thematic Map 26
Editing a Thematic Map 32
Deleting a Thematic Map 32



Introduction

A map that contains one or more Thematic Layers is termed a thematic map.

What is a Thematic Layer?

A Layer on the map that has had its visual style altered to represent data associated with that map
layer. For example, a Layer might contain suburb boundaries and have associated information about
the total population of each suburb. A Thematic can be applied to this Layer so that each suburb is
displayed in a different color depending on how large the population of the suburb is.

What is a Range Thematic Map?

ARanged thematic map groups all records into ranges and assigns different colors, symbols, patterns
or line style. For example, if you want to visualize the population of the world by growth rate, you
would shade countries according to their reported growth rate amounts.

What is an Individual Thematic Map?

An Individual thematic map show points, lines, or boundaries that are shaded by individual values
contained in a particular field. You can use both numerical and nominal values in individual values
maps. Individual thematic map is useful when you want to emphasize categorical differences in the
data rather than showing quantitative information For example, types of stores in a given area,
zoning classifications in a given area etc.

What is a Graduated Symbol Thematic Map?

Graduated symbol map uses symbols to represent different values. The size of the symbol varies
according to the values in the field. For example, use graduated symbols to show the number of
housing units in the city.
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Creating a Thematic Map

The Thematic Map tab allows you to create various themes on a map. You can create following
types of thematic maps:

• Ranged Thematic Maps
• Individual Value Thematic Maps
• Graduated Symbol Thematic Maps

The Thematic Map is not retained once you refresh your current page or change Map
Configuration.

Note:

Creating a Ranged Thematic Map

To create a Ranged thematic map, follow the steps given below:

1. Open the Thematics Map tab.
2. Click on Create New Thematics from drop-down list.
3. From the Table drop-down list select a table on which you would want to apply thematic.
4. From the Column drop-down list, select a column on which you would like to create thematic.

A Range Thematic can be created on a numeric column only.Note:

5. From the Visualization type drop-down list, select the Ranged thematic map.
6. SelectMap Geometries to style. You can choose from Polygon, Line or Pointmap geometries.

By default, the predominant map geometry is selected.

This option is available only when selected table contains two or more type of geometry.Note:

Table 1: Map Geometries Options

DescriptionOption

Select interval. It ranges from 2 to 16.Interval

Select to create ranges automatically using any one of the following methods. You
can select from:

Method

• Equal Count- It has the same number of records in each range.

• Equal Ranges- It divides records across ranges of equal size.
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DescriptionOption

• Standard Deviation- In this method the middle range breaks at the mean of your
values, and the ranges above and below the middle range are one standard
deviation above or below the mean.

Select the border style from the list. This option is available with polygon and line
geometries only.

Border > Style

Select the border color from color palette. This option is available with polygon
geometries only.

Border > Color

Select the size for border. This option is available with polygon and line geometries
only.

Border >Width

Select the start color of the range. The start color is same for all the map geometries.Fill > Start Color

Select the pattern from the list. This option is available with polygon geometries
only.

Fill > Pattern

Select the end color of the range. The end color is same for all the map geometries.Fill > End Color

Select the image icon from the drop-down list. This option is available with point
geometries only.

Image > Icon

Select the size of image icon. This option is available with point geometries only.Image > Size

7. Click on the Preview Legend button to preview legend range.
8. Enter a new name in the Thematic Map Name text box for the Thematic map or you may also

retain the default name. The default name is a combination of a table name, column name and
visualization name.

A thematic map name can be of maximum 50 characters. Special characters are not
allowed in thematic map names.

Note:

9. Click on the Create button to preview legend range. Each thematic map is added as a top level
map item. The thematic map is also listed in the Map Legend.

Once a thematic map is created, you can further edit or delete it from Map Legend. For more
information, refer to Editing a Thematic Map on page 32 and Deleting a Thematic Map on
page 32.

You can also print a range thematic map. For more information, refer to Printing Maps on page
50.
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The Thematic Map is not retained once you refresh your current page or change Map
Configuration.

Note:

Related Links
Printing Maps on page 50
Editing a Thematic Map on page 32
Deleting a Thematic Map on page 32

Creating an Individual Value Thematic Map

To create an Individual Value thematic map, follow the steps given below:

1. Open the Thematics Map tab.
2. Click on Create New Thematics from drop-down list.
3. From the Table drop-down list select a table on which you would want to apply thematic.
4. From the Column drop-down list, select a column on which you would like to create thematic.
5. From the Visualization type drop-down list, select the Individual Value thematic map.

Only 50 unique values are allowed to generate individual thematic map.Note:

6. SelectMap Geometries to style. You can choose from Polygon, Line or Pointmap geometries.
By default, the predominant map geometry is selected.

This option is available only when the selected table contains two or more types of
geometry.

Note:

7. Select a template from the Theme drop-down list. You may choose from a Default and Black
and White theme.
The legend attributes are displayed for the selected theme.

8. Click on the Legend image to change the color and attributes for any of the individual values. A
dialog box appears for changing attributes.

Table 2: Legend Attributes- Polygon

DescriptionOption

Select this tab to change attribute for fill color.Fill

Select the pattern from the drop-down list.Fill > Pattern

Select the fill color by dragging the color bar or simply clicking on the color in
the color box.

Fill > Color
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DescriptionOption

Select this tab to change border style.Border

Select the border color by dragging the color bar or simply clicking on the color
in the color box.

Border > Color

Select the border style from the list.Border > Style

Select the size for border.Border >Width

Click to apply changes.Apply

Click to exit without saving changes.Cancel

Table 3: Legend Attributes- Line

DescriptionOption

Select this tab to change attribute for line.Line

Select the line color by dragging the color bar or simply clicking on the color
in the color box.

Line > Color

Select the border style from the list.Line > Style

Select the width for border line.Line >Width

Click to apply changes.Apply

Click to exit without saving changes.Cancel

Table 4: Legend Attributes- Point

DescriptionOption

Select this tab to change image attribute. Select image from the list.Symbol

Select the size of image icon.Image > Size
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DescriptionOption

Select this tab to change the color of image.Color

Select the color for image icon by dragging the color bar or simply clicking
on the color in the color box.

Click to apply changes.Apply

Click to exit without saving changes.Cancel

9. Enter a new name in the Thematic Map Name text box for the Thematic map or you may also
retain the default name. The default name is a combination of a table name, column name and
visualization name.

A thematic map name can be of maximum 50 characters. Special characters are not
allowed in thematic map names.

Note:

10. Click on the Create button to preview legend range. Each thematic map is added as a top level
map item. The thematic map is also listed in the Map Legend.

Once a thematic map is created, you can further edit or delete it from Map Legend. For more
information, refer to Editing a Thematic Map on page 32 and Deleting a Thematic Map on
page 32.

You can also print an individual thematic map. For more information, refer to Printing Maps on
page 50.

The Thematic Map is not retained once you refresh your current page or change Map
Configuration.

Note:

Related Links
Printing Maps on page 50
Editing a Thematic Map on page 32
Deleting a Thematic Map on page 32

Creating a Graduated Symbol Thematic Map

To create a Graduated Symbol thematic map, follow the steps given below:

1. Open the Thematics Map tab.
2. Click on Create New Thematics from drop-down list.
3. From the Table drop-down list select a table on which you would want to apply thematic.
4. From the Column drop-down list, select a column on which you would like to create thematic.
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A Graduated Thematic can be created on numeric column only.Note:

5. From the Visualization type drop-down list, select the Graduated Symbol thematic map.
6. Select Map Geometries to style.

Table 5: Map Geometries Options

DescriptionOption

Select the symbol of your choice from the drop-down list.Shape

You can display symbols for positive data values. Click the color box to change the color.Positive

Select to display negative data values on map.Show Negative Value

You can also display symbols for negative data values. Click the color box to change the
color.

Negative

This option appears only if you have negative values in your data.Note:

Enter the diameter corresponding to the maximum value of selected column.Diameter

Displays the maximum value present in the selected column.For Value

You can choose size by constant, square root or log.Relative size by

7. Click on the Preview Legend button to preview legend range.
8. Enter a new name in the Thematic Map Name text box for the Thematic map or you may also

retain the default name. The default name is a combination of a table name, column name and
visualization name.

A thematic map name can be of maximum 50 characters. Special characters are not
allowed in thematic map names.

Note:

9. Click on the Create button to preview the Graduated Symbol thematic map. Each thematic map
is added as a top level map item. The thematic map is also listed in the Map Legend.

Once a thematic map is created, you can further edit or delete it from Map Legend. For more
information, refer to Editing a Thematic Map on page 32 and Deleting a Thematic Map.

You can also print graduated thematic map. For more information, refer to Printing Maps on
page 50.

The Thematic Map is not retained once you refresh your current page or change Map
Configuration.

Note:
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Related Links
Printing Maps on page 50
Editing a Thematic Map on page 32
Deleting a Thematic Map on page 32

Editing a Thematic Map

Once you create a thematic map, you can easily modify it. The Theme legends are listed automatically
in Map Legend when you create a thematic map. It displays colors, symbols, and styles used in the
map. To edit a thematic map, follow the steps given below:

1. Open the Map Legend on the right side of the map.

2. Click on the Show\Hide Overlay on the Map check box next to the required map overlay in
the map legend to turn on a thematic map overlay.

3. Click on the Edit map icon to edit the thematic map. The selected thematic map name appears
on the left pane under Thematic Map Name text box.

You cannot edit thematic table name.Note:

4. Modify the current thematic map by choosing options from Map Geometries.
5. Click on the Apply button to apply changes to thematic map.

Deleting a Thematic Map

Once you create a thematic map, you can easily delete it. The Theme legends are listed automatically
in Map Legend when you create a thematic map. It displays colors, symbols, and styles used in the
map.

To delete a thematic map, follow the steps given below:

1. Open the Map Legend on the right side of the map.

2. Click on the Show\Hide Overlay on the Map check box next to the required map overlay in
the map legend to turn on a thematic map overlay.

3. Click on the Delete icon to delete a thematic map.
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5 - Working with
Annotations

The functions available in MapInfo Stratus are controlled by the
administrator for each organization and some users may not have

Note:

these tools enabled, whilst others may only have measuring tools
enabled instead of the full annotation tools.

The following topics provide help on working with annotations:

In this section

Annotations 34
Measuring Distance and Area 48



Annotations

MapInfo Stratus provides various types of annotation features that you can draw on the map. You
can use these annotation features to highlight or label certain areas. The annotations can be exported
as a Google KML file that you can share with others and are included in the PDF printouts you can
create from MapInfo Stratus. You can also import KML annotations that you have drawn in other
applications. If you have the query capability enabled you can also search and display information
from map layers where they overlap with the annotations. You can also pick features from the map
and add them to your annotations. Whilst adding you are given the option to buffer the feature by
a certain value.

For example if you want to see all the map information within 100 meters of an existing area, you
can pick the area on the map, buffer it by 100 meters and then use the resulting annotation in a
query. The annotation features are managed by Annotation Manager.

Draw a Shape Annotations

The Draw a Shape annotation button allows you to choose from following shapes:

Draw Polygon

To draw a polygon, follow the steps given below:

1. From Shape Annotation drop-down list, select Draw Polygon .
2. Click on the map once to start the first point.
3. Move the mouse and click again to enter the second point.
4. Repeat the above step for as many points that you wish to add.
5. When you are adding the last point, add it using a double click of the mouse. This will end the

drawing mode and complete your polygon.

If you click the map and drag the mouse whilst drawing you can pan the map. This is
useful if you want to carry on drawing past the edge of the current map view. A polygon
must have at least 3 points to be added to the map.

Note:

Click on Navigate Map icon on the toolbar to release the selected annotation feature.Note:

Styling Polygon Annotation
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You can change style of polygon annotation like, boundary and fill color, fill pattern, border style

and border width from Annotation Manager > Style Annotation . For more information,
refer Styling Annotation.

Related Links
Select Annotation Tool on page 44
Editing Annotation Properties on page 42
Styling Annotation on page 43

Draw Circle

To draw a circle, follow the steps given below:

1. From Shape Annotation drop-down list, select Draw Circle .
2. Click on the map where the center of the circle will be and drag mouse outwards to draw the

circle.
3. Release the mouse to complete the drawing and add the circle to the map.

Click on Navigate Map icon on the toolbar to release the selected annotation feature.Note:

Styling Circle Annotation

You can change style of circle annotation like, boundary and fill color, fill pattern, border style

and border width from Annotation Manager > Style Annotation . For more information,
refer Styling Annotation.

Related Links
Select Annotation Tool on page 44
Editing Annotation Properties on page 42
Styling Annotation on page 43

Draw Ellipse

To draw a ellipse, follow the steps given below:

1. From Shape Annotation drop-down list, select Draw Ellipse .
2. Click on the map where one corner of the ellipse will be and drag mouse outwards to draw the

ellipse.
3. Release the mouse to complete the drawing and add the ellipse to the map.

Click on Navigate Map icon on the toolbar to release the selected annotation feature.Note:

Styling Ellipse Annotation
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You can change style of ellipse annotation like, boundary and fill color, fill pattern, border style

and border width from Annotation Manager > Style Annotation . For more information,
refer Styling Annotation.

Related Links
Select Annotation Tool on page 44
Editing Annotation Properties on page 42
Styling Annotation on page 43

Draw Square

To draw a square, follow the steps given below:

1. From Shape Annotation drop-down list, select Draw Square .
2. Click on the map where the centre of the square will be and drag mouse outwards to draw the

square.
3. Move the mouse around to rotate the square whilst drawing it.
4. Release the mouse to complete the drawing and add the square to the map.

Click on Navigate Map icon on the toolbar to release the selected annotation feature.Note:

Styling Square Annotation

You can change style of square annotation like, boundary and fill color, fill pattern, border style

and border width from Annotation Manager > Style Annotation . For more information,
refer Styling Annotation.

Related Links
Select Annotation Tool on page 44
Editing Annotation Properties on page 42
Styling Annotation on page 43

Draw Rectangle

To draw a rectangle, follow the steps given below:

1. From Shape Annotation drop-down list, select Draw Rectangle .
2. Click on the map where one corner of the rectangle will be and drag mouse to draw the rectangle.
3. Release the mouse to complete the drawing and add the rectangle to the map.

Unlike the square, the rectangle cannot be rotated.Note:

Click on Navigate Map icon on the toolbar to release the selected annotation feature.Note:
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Styling Rectangle Annotation

You can change style of rectangle annotation like, boundary and fill color, fill pattern, border style

and border width from Annotation Manager > Style Annotation . For more information,
refer Styling Annotation.

Related Links
Select Annotation Tool on page 44
Editing Annotation Properties on page 42
Styling Annotation on page 43

Draw Concentric Ring

To draw a concentric ring on a map, follow the steps given below:

1. From Shape Annotation drop-down list, select Draw Concentric Ring .
2. Click on the map where you want to add concentric ring and drag mouse outwards to draw a

circle. The radius of the drawn circle becomes the initial outer radius of the rings. The Add
Concentric Ring dialog box appears with following options:

DescriptionOptions

Enter x coordinateX- Coordinate

Enter y coordinateY-Coordinate

Enter\change outer radius value for the outermost ring. You
can edit the outer radius to a different value.

Outer Most Radius

Enter the total number rings. You can enter 2 to 5 rings only.

For example, if the number of rings is 2 then 2 rings will be
drawn with the first ring having inner radius as 0 and second

Number of Rings

ring having outer radius as specified in the "Outermost
Radius" field.

Each individual ring will be a separate annotation that will
be listed in Annotation Manager. You can query in each
ring individually or with other annotations (multiple select)
in Query Builder.

Select to create rings at equal distances.Equidistant
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DescriptionOptions

Select to create rings at customized distances.

The radius text box appears on the basis of total number
of rings. The last radius text box cannot be edited. It displays
the value entered in Outermost Radius text box.

Custom

Click Save. The Concentric Ring appears on the map.Save

Click Cancel to exit Add Concentric Ring dialog box
without creating concentric ring on the map.

Cancel

3. Click on the Select Annotation Tool icon on the toolbar to view and edit ring annotation
properties.

4. Click on the ring to see and edit its annotation properties. For more information, refer Editing
Annotation Properties on page 42.

Click on Navigate Map icon on the toolbar to release the selected annotation feature.Note:

Styling Concentric Ring Annotation

You can change style of concentric ring annotation like, boundary and fill color, fill pattern, border

style and border width from Annotation Manager > Style Annotation . For more
information, refer Styling Annotation.

Related Links
Editing Annotation Properties on page 42
Select Annotation Tool on page 44
Styling Annotation on page 43

Draw Line

To draw a line, follow the steps given below:

1. From the toolbar, select Draw Line
2. Click on the map once to start the first point.
3. Move the mouse and click again to enter the second point.
4. Repeat the above step for as many points that you wish to add.
5. When you are adding the last point, add it using a double click of the mouse. This will end the

drawing mode and complete your line.
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If you click the map and drag the mouse whilst drawing you can pan the map. This is
useful if you want to carry on drawing past the edge of the current map view. A line must
have at least two points to be added to the map.

Note:

Click on Navigate Map icon on the toolbar to release the selected annotation feature.Note:

Styling Line Annotation

You can change style of line annotation like, color, size and width from Annotation Manager

> Style Annotation . For more information, refer Styling Annotation.

Related Links
Select Annotation Tool on page 44
Editing Annotation Properties on page 42
Styling Annotation on page 43

Draw Point

To add a point annotation to the map follow the steps given below:

1. From the toolbar, select Draw Point .
2. Click on the map once where you wish to add the point. The point will be added to the map.

Click on Navigate Map icon on the toolbar to release the selected annotation feature.Note:

Styling Line Annotation

You can change style of point annotation like, color, style, size from Annotation Manager >

Style Annotation . For more information, refer Styling Annotation.

Related Links
Select Annotation Tool on page 44
Editing Annotation Properties on page 42
Styling Annotation on page 43

Text Annotation

To add a text annotation to the map follow the steps given below:

1. From the toolbar, select Text Annotation .
2. Click on the map once to register the center point for the text.
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The text annotation dialog box appears.

3. Type the text you wish to add and click OK.

The text will be added to the map.

You cannot query on a Text Annotation. Summarize data is not supported for Text
Annotation.

Note:

Click on Navigate Map icon on the toolbar to release the selected annotation feature.Note:

Styling Text Annotation

You can apply style to text annotation like, font, size and font color from Annotation Manager

> Style Annotation . For more information, refer Styling Annotation on page 43.

Related Links
Select Annotation Tool on page 44
Editing Annotation Properties on page 42
Styling Annotation on page 43

Pick and Buffer Map Feature

To pick a map feature and add it to the map as an annotation, follow the steps given below:

1. From the toolbar, select the Pick and Buffer Map icon .
2. Click on the map where the map feature is located.

You will be shown a dialog listing of all the map features found at that location.

3. Tick the features you wish to add as annotations. Each would be added as a separate annotation.
4. Optionally, enter a value for the buffer. Each map feature will be increased in size from its edge

by the buffer amount before being added. You can select various measurement units from the
drop-down list. The supported measurement units are Meters, Feet, Yards, Kilometers, Miles,
Acres, and Hectares.

5. Click Save.

All the selected annotations will be added to the map.
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Annotation Manager

To manage all the annotations from one place you can use the annotation manager from the
toolbar. The Annotation Manager highlights total number of annotations drawn on the map. The
following options are available in annotation manager:

DescriptionOptions

Toggles the visibility of all of the annotations.Show/Hide All Annotations on
Map

Close the annotation manager.

Toggles the visibility of individual annotation.

View and edit properties of individual annotation. For more information, refer Editing
Annotation Properties on page 42.

Edit annotation style of selected annotation like color, size, pattern. For more
information, refer Styling Annotation on page 43.

Delete individual annotations.

Export the annotations to a Google KML file to your computer.Export

Import a new set of annotations from a Google KML file you have on your computer.Import

Summarize data within single or multiple annotations. It displays the sum, average,
min and max of numeric data that falls within the selected annotations. For more

Summarize Data

information, refer Summarize Data in Multiple Annotation on page 47 and
Summarize Data in a Single Annotation on page 45.

Query on multiple annotations.Query

Query on a Text Annotation is not allowed.Note:

Delete all annotations.Delete All
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Editing Annotation Properties

There are two ways to view and edit annotation properties.

Edit Annotation

The Edit Annotation icon allows you to view and edit properties of individual annotation. To
edit annotation properties, follow the steps given below:

1. Click on the Annotation Manger icon on the toolbar. The Annotation Manger dialog box
appears.

2. Select the Annotation that you want to view or edit.

3. Click on the Edit Annotation icon. The Properties dialog box for selected annotation appears
under the Annotation tab.

DescriptionProperties

Displays name of the selected annotation. For example, circle, point,
line, ring etc.

Annotation

Displays the measurements of selected annotations like area, length
and perimeter. You can select various measurement units from theMeasurement Units

drop-down list. The supported measurement units are Meters, Feet,
Yards, Kilometers, Miles, Acres, and Hectares. The default
measurement unit will be the configured map unit for all annotations.

Displays the inner radius of a circle or ring annotation.Inner Radius

This option is available with a circle or ring annotation only.Note:

Displays the outer radius of a circle or ring annotation.Outer Radius

This option is available with a circle or ring annotation only.Note:

Enter a buffer value to apply to the selected annotation.Apply Buffer

Enter the value of x to relocate an existing annotation to a new location.X

Enter the value of y to relocate an existing annotation to a new location.Y

Select to input values for longitude and latitudes in decimal degree.Longitude-Latitude
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4. Click on the Delete icon to delete the selected annotation.
5. Click on the Apply button to apply changes to annotation properties.

Related Links
Select Annotation Tool on page 44

Styling Annotation

The Style Annotation button allows you to edit color, size and pattern of selected annotation.
To edit annotation properties, follow the steps given below:

1. Click on the Annotation Manger button on the toolbar. The Annotation Manger dialog box
appears.

2. Select the Annotation that you want to style.

3. Click on the Style Annotation button. The edit properties for styling annotation are displayed
at the bottom of Annotation Manager dialog box.

DescriptionProperties

Displays style properties for polygon, circle, ellipse, square and
rectangle.

Shape Annotation >

Click to open the color palette and select the color for
annotation.

Boundary and Fill Color

Select the fill pattern for annotation. You can choose from no
fill, solid pattern and graphic pattern.

Fill Pattern

Select border line style from the drop-down list.Border Style

Change the size of the border. You may choose from 1pt to
7pt.

Border Width

Line Annotation >

Click to open the color palette and select the color for line
annotation.

Line Color

Select the line style from drop-down list. You may choose from
dotted, solid and dashed line. By default, the annotation has
solid line.

Line Style
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DescriptionProperties

Change the size of the line annotation. You may choose from
1pt to 7pt.

Line Width

Point Annotation >

Click to open the color palette and select the color for
annotation.

Fill Color

Select the style from the drop-down list.Point Style

Select the size of the point annotation. You may choose from
5 to 20pt.

Point Radius

Text Annotation >

Click to open the color palette and select the color for the text
annotation.

Text Color

Select a new font from drop-down list for text annotation.Font

Change the size of text annotation.Font Size

4. Click on the Apply button to apply styling to selected annotation.

5. Click on the Close button to close Style Annotation dialog box without making any change.

Select Annotation Tool

The Select Annotation Tool on the toolbar allows you to select an existing annotation and
view or modify its properties. Follow the steps given below to edit annotation properties:

1. From the toolbar, select the Select Annotation Tool .
2. Move the mouse over the map. As you move, annotations that can be selected is highlighted in

bold outline.
3. Click on the annotation to select it. The selected annotation will turn orange and the edit properties

dialog box appears for selected annotation under the Annotation tab.
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DescriptionProperties

Displays name of the selected annotation. For example, circle, point,
line, ring etc.

Annotation

Displays the measurements of selected annotations like area, length
and perimeter. You can select various measurement units from theMeasurement Units

drop-down list. The supported measurement units are Meters, Feet,
Yards, Kilometers, Miles, Acres, and Hectares. The default
measurement unit will be the configured map unit for all annotations.

Displays the inner radius of a circle or ring annotation.Inner Radius

This option is available with a circle or ring annotation only.Note:

Displays the outer radius of a circle or ring annotation.Outer Radius

This option is available with a circle or ring annotation only.Note:

Enter a buffer value to apply to the selected annotation.Apply Buffer

Enter the value of x to relocate an existing annotation to a new location.X

Enter the value of y to relocate an existing annotation to a new location.Y

Select to input values for longitude and latitudes in decimal degree.Longitude-Latitude

4. Click on the Delete icon to delete the selected annotation.
5. Click on the Apply button to apply changes to annotation properties.

Related Links
Edit Annotation on page 42

Summarize Data in a Single Annotation

You can summarize data in\within a single annotation. It displays the sum, average, min and max
of numeric data that falls within the selected annotation. To get summarized data for the selected
annotation:

1. Click on the Annotation Manger icon on the toolbar. The Annotation Manger dialog box
appears.
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2. Select the Annotation for which you want to summarize data.

3. Click on the edit icon. The properties dialog box appear for selected annotation.
4. Click on the Summarize Data tab. The Summarize Data for the selected annotation appears

under Summarize Data tab

DescriptionOptions

Select the table for which you want to summarize data.For Table

Select whether the data should be within or intersecting the
annotation. You may select Features intersect these annotations

Where

or Features are within this annotation option. Intersecting is the
only option for lines and points while polygons can have either option.

Displays the total number of features found in selected area.Count

Displays the sum of corresponding values for numeric data for each
table column.

Sum

Displays the average of corresponding values for numeric data for
each table column.

Average

Displays the minimum value of corresponding values for numeric
data for each table column.

Min

Displays the maximum value of corresponding values for numeric
data for each table column.

Max

Exports the summarize data to a csv file.Export

Close the Summarize Data dialog box.Close

Exports only selected data to a csv file.Export Selected

Summarize data is not supported for Text Annotations.Note:
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Summarize Data in Multiple Annotation

You can summarize data in\within multiple annotations. It displays the sum, average, min and max
of numeric data that falls within the selected annotations. To get summarized data for multiple
annotations:

1. Click on the Annotation Manger icon on the toolbar. The Annotation Manger dialog box
appears.

2. Select single or multiple Annotations for which you want to summarize data.
3. Click on the Summarize Data link at the bottom of Annotation Manager dialog box. The

Summarize Data for selected annotations dialog box appears with following options:

DescriptionOptions

Select the table for which you want to summarize data.For Table

Select whether the data should be within or intersecting the
annotation. You may select Features intersect these annotations

Where

or Features are within this annotation option. Intersecting is the
only option for lines and points while polygons can have either option.

Displays the total number of features found in the selected area.

For tables with no numeric columns, only the record count is
displayed.

Count

Displays the sum of corresponding values for numeric data for each
table column.

Sum

Displays the average of corresponding values for numeric data for
each table column.

Average

Displays the minimum value of corresponding values for numeric
data for each table column.

Min

Displays the maximum value of corresponding values for numeric
data for each table column.

Max

Exports the summarize data to a csv file.Export

Closes the Summarize Data dialog box.Close
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DescriptionOptions

Exports only selected data to a csv file.Export Selected

Summarize data is not supported for Text Annotations.Note:

Measuring Distance and Area

In this topic:

Navigate in the Map

To navigate in the map:

1. Select the Navigate Map tool and click on the map screen.
2. Hold the mouse, click down and drag the cursor across the screen to navigate.
3. Click on the map to see the information of selected point.

Measuring Distance

To measure distances on the map:

1. From the measuring toolbar, select Measure Line .
2. Click on the map once to start the first point.
3. Move the mouse and click again to enter the second point.
4. Repeat the above step for as many points that you wish to add.
5. When you are adding the last point, add it using a double click of the mouse. The distance

measured is shown in measurement dialog box.

You can measure distance in meters, feet, yards, kilometers and miles.Note:
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Measuring an Area

To measure an area on the map:

1. From the measuring toolbar, select Measure Area .
2. Click on the map once to start the first point.
3. Move the mouse and click again to enter the second point.
4. Repeat the above step for as many points that you wish to add.
5. When you are adding the last point, add it using a double click of the mouse. The area measured

is shown in measurement dialog box.

You can measure area in meters, feet, yards, kilometers, miles, acres and hectares.Note:

Clearing the Feature

To clear the drawn area or distance on the map:

1. From the measuring toolbar, click on the Clear Feature button.
2. The drawn area or line is removed from map.
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6 - Printing Maps
MapInfo Stratus allows you to print maps with annotations including
measured distances and areas. It also allows you to preview your map
before printing.

The following topics provide help on printing maps:

In this section

Print Preview 51
Print to Scale 51
Print Map to PDF 52



Print Preview

To preview the map before printing:

1. In the Map Toolbar, click Print .

The Print Settings dialog box appears.

You may or may not see the scale print option in the Print Settings dialog box. It is
available on the basis of settings applied by the MapInfo StratusAdministrator.

Note:

2. Enter the title for the map in the Title text box.
3. Select the template from the Template drop down list. You can select from following templates:

• Portrait
• Landscape
• Portrait Map Only
• Landscape Map Only

4. Select the scale to print from Scale drop-down list. The drop down lists the current scale (as it
would appear if the current visible map is fitted into the print template) and also a number of other
scales. You can also type in a specific scale of your choice. The range of available scales is
chosen based on the current zoom level to ensure that the print appears at a good resolution. If
the scale you want is not in range then try zooming in or out and then printing.

5. Click on the Preview button to see the PDF print preview of Map.
6. Click Print and select the printing options that you want in the print preferences dialog. The print

preferences dialog will differ based on your specific printer and PDF viewer.

When After previewing the print PDF and before printing please ensure that you uncheck
any Fit to Page options in the print preferences dialog. Sometimes these options are

Note:

show when clicking the properties button on the dialog. For more information, refer Print
to scale.

7. Click on the Preview button to see the print preview of Map.
8. Select the printing options that you want, and then click Print.

Print to Scale

The print templates in MapInfo Stratus are designed to specify a page size that is slightly less than
full A4 at 200mm by 287mm. This has been done to ensure that on most printers and printer drivers
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the output does not need to be shrunk to fit into the printable area of the paper. They should therefore
print at the exact scale intended. However there can be exceptions to this:

1. On some older printers and print drivers we have seen that output can still become scaled down
(shrunk) if the printer cannot print to a printable area as large as 200mm x 287mm.

2. In some cases the printer driver offers the ability to Fit (or Scale to Fit) into the printable area. In
these cases it is possible that the print may become scaled up (grown).

When printing scaled PDF’s we strongly recommend disabling any options like "shrink to Printable
Area” or "Fit to Printable Area" on your print menu to ensure that there is no page scaling, otherwise
the output will not be at the exact scale that was chosen.

In order to assist with validating the output the actual dimensions of the printed map should be as
follows for each of the standard print templates.

• Landscape Map Only 27.7 cm x 15.0 cm
• Landscape 21.7 cm x 15.5 cm
• Portrait Map Only 19.0 cm x 24.5 cm
• Portrait 19.0 cm x 17.0 cm

Print Map to PDF

You can Print your map to PDF from supported browsers like Chrome and Mozilla Firefox.

Chrome

To print the web page you're viewing in Chrome, press Ctrl+P.

For more information on Printing through Chrome browser, refer to their website.Note:

Firefox

To print the web page you are viewing in Firefox, click on the Firefox button at the top of the Firefox
window, (File menu in Windows XP) and select Print.

For more information on Printing through Firefox browser, refer to their website.Note:
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7 - Linking Maps
MapInfo Stratuss allows you to copymap link for Email or sharing. It displays
the URL of the current location on map.

The following topics provide help on linking maps:

In this section

Copying Map Link 54



Copying Map Link

Copying map link in MapInfo Stratus is simple. To copy a link:

1. In the Map toolbar, click Link .

The Link dialog box appears.

2. Select Copy from the right click menu.
3. You can now paste link to an Email.
4. Click Cancel to close the Link dialog box.
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8 - Support
In this section:

In this section

Frequently Asked Questions 56



Frequently Asked Questions

I just zoomed out and the legend control now shows a layer as disabled

In MapInfo Stratus the administrator can determine the zoom levels at whichmap layers are displayed.
This is called "Zoom Layering". When a map layer becomes disabled you need to zoom in (or in
some cases zoom out) to make the layer visible. Normally, layers that show very detailed information
are enabled only when you zoom in.

Where is the zoom layering stored?

The zoom layering is stored as the part of layer definition, and cannot be viewed or changed by
users after it has been created and uploaded into MapInfo Stratus.

Why are disabled layers not getting reflected in the PDF print?

This is an expected behavior. The layers which are disabled are not shown on the map or the print
PDF. You can zoom in to show layers for both.
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©2015 Pitney Bowes Software Inc. All rights reserved. MapInfo and Group 1 Software are trademarks
of Pitney Bowes Software Inc. All other marks and trademarks are property of their respective
holders.

Contact information for all Pitney Bowes Software offices is located at:
http://www.pb.com/contact-us/
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